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SR Exercise 1

	1.  
	On the Workbook Wizard - Step 1 screen, In the Select Objects to display in the worksheet section, click the Graph checkbox to remove the checkmark.
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	2.  
	Click the Page Items checkbox to remove the checkmark.
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	3.  
	Click the Next button.
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	4.  
	On the Step 2 screen, scroll down the Available Items list and click the + sign ajacent to Ps Um Stud Ext Vw.

	5.  
	Scroll down and click on Institution to select it.

Next, click the Add button to move the item into the Selected section..
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	6.  
	Scroll down the Available Items section and click on Um Unt Tak Prg Rc to select it.

	7.  
	Click the Add button.

	8.  
	Scroll up the Available Item section and click on FTE to select it.

	9.  
	Click the Add button.

	10.  
	Next, click the Conditions tab.
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	11.  
	Click the New button.
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	12.  
	Click on New Condition...
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	13.  
	On the New Condition screen, click on the drop-down arrow in the Item field.

[image: image8.png]




	14.  
	From the drop-down list, click on More Items to select it.
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	15.  
	From the Select Item screen, click scroll down and click on Strm to select it.
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	16.  
	Click the OK button.
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	17.  
	Next, click your cursor in the Values field.

	18.  
	 Type 0910 

	19.  
	Click the OK button.
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	20.  
	Click the New button.
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	21.  
	Click on New Condition... .
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	22.  
	On the New Condition screen, click on the drop-down arrow in the Item field.
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	23.  
	Click on More Items to select it.
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	24.  
	On the Select Item screen, scroll down and click on Row check to select it.

	25.  
	Click the OK button.
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	26.  
	Next, click your cursor in the Values field.

	27.  
	Type Y into the field.

	28.  
	Click the OK button.
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	29.  
	Next, click the Calculations tab.
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	30.  
	Click the New button.
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	31.  
	Click on New Calculation... .
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	32.  
	On the New Calculation screen, enter a name for the calculation in the What do you want to name this calculation? field. 

For this example, enter FT_PT.

	33.  
	Next, click on the drop-down arrow in the Show field.

	34.  
	Click on Functions to select it.

	35.  
	Click on the + sign adjacent to All Functions.

	36.  
	Scroll down and click on CASE to select it.

	37.  
	Click the Paste button.
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	38.  
	In the Calculation section, click your cursor after WHEN.

	39.  
	Click on the drop-down arrow in the Show field.

	40.  
	Click on Available Items to select it.

	41.  
	Click on the + sign adjacent to Ps um stud ext vw.

	42.  
	Scroll down and click on Academic Load to select it.

	43.  
	Click the Paste button.

	44.  
	In the calculation section, enter an = sign after load.

	45.  
	Next, enter 'F' after the = sign.

	46.  
	Next, delete condition1 from the Calculation.

	47.  
	Click your cursor after THEN in the Calculation section.

	48.  
	Enter 'Full-Time' after THEN.

	49.  
	Delete expr1 from the calculation.

	50.  
	Next, enter 'Part-Time' after Else in the calculation.

	51.  
	Delete expr2 from the calculation.

	52.  
	Click the OK button on the New Calculation screen.
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	53.  
	Click the New button.
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	54.  
	Click on New Calculation... .
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	55.  
	Enter a name for the calculation in the What do you want to name this calculation? field. 

For this example, enter HEADCNT.

	56.  
	Click on the drop-down arrow in the Show field.

	57.  
	Click on Functions to select it.

	58.  
	Scroll down and click on CASE to select it.

	59.  
	Click the Paste button.

	60.  
	Click your cursor after WHEN in the Calculation section.

	61.  
	Click on the drop-down arrow in the Show field.

	62.  
	Click on Available Items to select it.

	63.  
	Click on the + sign adjacent to Ps um stud ext vw to select it.

	64.  
	Scroll down and click on Row Check to select it.

	65.  
	Click the Paste button.

	66.  
	Next, enter ='Y' 

	67.  
	Delete condition1 from the calculation.

	68.  
	Enter 1 after THEN in the calculation.

	69.  
	Delete expr1 from the calculation.

	70.  
	Enter 0 after ELSE in the calculation.

	71.  
	Delete expr2 from the calculation.

	72.  
	Enter SUM( betore CASE in the calculation.

	73.  
	Enter ) after END in the calculation.

	74.  
	Click the OK button.
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	75.  
	On the Step 2 screen, click the Next button.
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	76.  
	On the Step 3-Table Layout screen, hold your cursor down on the FT_PT column heading.

	77.  
	Drag the FT_PT heading to the left so it is positioned after Institution.

	78.  
	Next, hold your cursor down on the HEADCNT column heading.

	79.  
	Drag the HEADCNT heading to the left so it is positioned after FT_PT.

	80.  
	Click the Next button.
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	81.  
	On the Step 4 - Sort screen, click the Add button.
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	82.  
	In the Sort by row under Column, click on the drop-down arrow.

	83.  
	Click on Institution to select it.

	84.  
	Next, in the Sort by column, click on the drop-down arrow.

	85.  
	Click on Group Sort to select it.

	86.  
	Click the Next button.
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	87.  
	Click the Finish button.
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	88.  
	Next, from the Discoverer menu, click on Tools to select it.

	89.  
	From the Tools drop-down menu, click on Totals to select it.

	90.  
	Click the New button.
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	91.  
	Click on New Total... to select it.

	92.  
	Click on the Which data point would you like to create a total on? drop-down menu.

	93.  
	Click on All Data Points to select it.

	94.  
	In the What kind of total do you want? field, click on the drop-down arrow and select Sum.
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	95.  
	In the Where would you like your total to be shown? section, click on Subtotal at each change in: to select it.

	96.  
	Next, click on the Subtotal at each change in: drop-down arrow.

	97.  
	Click on Institution to select it.

	98.  
	Next, remove the checkmark adjacent to Generate label automatically.

	99.  
	Click on the drop-down arrow in the What label do you want to be shown? section and select Insert Value.

	100.  
	Delete Sum from field and enter SubTotal in its place.

	101.  
	Click the OK button.

	102.  
	On the Edit Worksheet screen, Click the New button.

	103.  
	Click on New Total... to select it.
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	104.  
	Click on the Which data point would you like to create a total on? drop-down menu.
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	105.  
	Click on All Data Points to select it.
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	106.  
	Remove the checkmark adjacent to Generate label automatically.
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	107.  
	In the What label do you want to be shown? field, delete Sum from the field and enter Grand Total.

	108.  
	Click the OK button.
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	109.  
	Click the OK button on the Edit Worksheet screen.
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	110.  
	Double-click in the edit title field.

	111.  
	On the Edit Title screen, enter ENROLLMENT SUMMARY in the Title field.

	112.  
	Press [Enter].

	113.  
	Click the Insert drop-down arrow.
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	114.  
	Click on Conditions to select it.
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	115.  
	Press [Enter].

	116.  
	Click the OK button.
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	117.  
	From the Discoverer menu, click on File to select it.

	118.  
	From the File menu, click on Page Setup... to select it.

	119.  
	On the Page Setup screen, click the Header/Footer tab.
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	120.  
	In the Header section, delete &WorksheetName from the Right field.

	121.  
	In the Footer section, delete &PageNumber from the Center field.

	122.  
	Next, click your cursor in the Footer Left: field.

	123.  
	Click the Insert button.
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	124.  
	Click on Workbook Name to select it.
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	125.  
	Click the OK button.
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	126.  
	Next, click on the FT_PT column heading to select it.
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	127.  
	From the Discoverer menu, click on Format to select it.
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	128.  
	Click on Item Formats... to select it.
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	129.  
	On the Format screen, with FT_PT selected, click on Edit Heading... to select it.
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	130.  
	On the Edit Heading screen, delete FT_PT from the Heading field.
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	131.  
	Enter Full/Part in its place.

	132.  
	Click the OK button.
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	133.  
	On the Format screen, click on FTE SUM to select it and the click the Edit Heading... button.
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	134.  
	Delete FTE SUM from the Heading field.

	135.  
	Enter FTE in the Heading field and then Click the OK button.
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	136.  
	Next, click on HEADCNT to select it.

	137.  
	Click the Edit Heading... button.
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	138.  
	Delete HEADCNT from the Heading field and enter Headcount in its place.

	139.  
	Click the OK button.
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	140.  
	Next, Click on Um Unt Tak Prg Rc SUM to select it.

	141.  
	Click the Edit Heading... button.
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	142.  
	Delete Um Unt Tak Prg Rc SUM from the Heading field and replace it with Credit Hours.

	143.  
	Click the OK button.
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	144.  
	Click the OK button.

[image: image59.png]




	145.  
	Click the Refresh button to run the report.
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	146.  
	To expand the FTE column, hold your cursor down on the right-side of the FTE column heading and drag it to the right to expand the column.

	147.  
	Click on the Headcount column heading and click on the Format menu to select it.

	148.  
	Click on Data... to select it.

	149.  
	On the Format Data screen, click on the Number tab.
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	150.  
	In the Decimal Places field, enter 0 in the field.

	151.  
	Place a checkmark in the Use 1000 Separator (,) checkbox.
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	152.  
	Click the OK button.
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	153.  
	From the Discoverer menu, click on File to select it.

	154.  
	Click Save As... .

	155.  
	On the Save Workbook to Database screen, enter Ex 1 in the New name field.

	156.  
	Click the Save button.
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	157.  
	End of Procedure.
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